Designing Reality – Incorporating Point Clouds into Utility Design

Aaron Mason
Anchorage Municipal Light & Power

Forest Roy
Anchorage Municipal Light & Power

Learning Objectives

- Identify different methods of reality capture used to create point clouds
- Learn different methods to create surfaces using point clouds
- Import formats of surfaces from different data sources into AutoCAD Utility Design
- Create 3D design features by referencing imported surfaces and point clouds to accurately generate 3D designs

Description

Utilizing point clouds from several different reality capture methods (including photogrammetry, tripod mounted laser scanners, handheld laser scanners, ground penetrating radar, aerial LiDAR, and 3D underground locates) we will generate 3D designs in AutoCAD Utility Design. Linework and terrain models generated from point clouds in Civil 3D will be imported into AutoCAD Utility Design to automate 3D design and elevations by accurately referencing 3D design elements to the terrain. We will reference in several other point clouds from different reality capture methods and generate 3D design from point cloud geometry. This includes aligning proposed underground utilities to existing utilities based off point cloud geometry and adjusting alignments of underground utility routes based off 3D alignments of utilities. This class is a follow up to the AU 2016 class by Forrest Roy "Capturing Reality, Incorporating Reality Capture into Utility Design and use in SUE".

Your AU Expert(s)

Aaron Mason is Lead Drafter and CPR engineer at Anchorage Municipal Light & Power (AMLP) with over 15 years’ experience in civil/utility construction, including surveying, inspection, drafting, reality capture and geographic information system (GIS). Through over 10 years of drafting experience, Aaron has developed drafting standards, workflows, and configuration requirements for how AutoCAD software works throughout the company’s engineering department. He is currently working on innovating new ways to incorporate reality capture using different methods into AutoCAD Utility Design software, including point clouds from photogrammetry (tripod and drone mounted cameras), ground-penetrating radar, handheld laser scanners, tripod mounted scanners, aerial LiDAR (light detection and ranging), and 3D underground electrical locates. Aaron is currently working on upgrades to AutoCAD Utility Design 2016 software to automate infrastructure lifecycle by streamlining asset management and material allocations through integrations between AutoCAD software, GIS, and asset management systems.
Forrest Roy has been working in the utility industry for over 15 years. He is currently the lead underground cable locator for Anchorage Municipal Light and Power (AMLP). In this role, he is responsible for managing the excavation damage-prevention program for the entire utility. In 2014, using ReCap software, he helped develop the 3D modeling program that has enabled AMLP to begin modeling their underground vaults and infrastructure. Forrest Roy and Everett Clary of AMLP submitted and won the Excellence in Infrastructure award during Autodesk University 2014. Forrest is currently involved in using new technologies and techniques to create 3D models and point clouds in ReCap software, Remake (formerly Memento), and InfraWorks. He is leading the charge for more reality-capture technology to bring realism and substance to current 2D drawings, including laser scanning, structured light, photogrammetry, 360 photography and providing a true mobile solution for field crews.

Table of Contents
Designing Reality – Incorporating Point Clouds into Utility Design ........................................... 1
Introduction ........................................................................................................................................... 3
   About Anchorage Municipal Light and Power ................................................................................. 3
   How we Got Here ............................................................................................................................. 3
Reality Capture Methods .................................................................................................................... 4
   Survey Data ..................................................................................................................................... 4
   Photogrammetry ............................................................................................................................... 4
   Terrestrial Laser Scans .................................................................................................................... 4
   Aerial LiDAR .................................................................................................................................. 4
   Ground Penetrating Radar ............................................................................................................... 5
   3D Underground Locates .............................................................................................................. 5
Creating Surfaces from Point Clouds ................................................................................................... 5
   Creating Point Clouds in ReCap .................................................................................................... 5
   Generate Terrain Models from Point Clouds in Civil 3D................................................................. 8
   Generate Terrain Models from Point Clouds in Infraworks ......................................................... 8
   Export Terrain Model from Infraworks ......................................................................................... 10
   Import Infraworks Terrain into Civil 3D ....................................................................................... 12
   Export Terrain Model from Civil 3D ............................................................................................. 12
Importing Surfaces and Point Clouds into Design ............................................................................. 13
   Import Terrain Models into Map3D .............................................................................................. 13
   Create Surface from Civil 3D Export in AutoCAD Utility Design ................................................ 13
   Import Point Clouds into AutoCAD ............................................................................................ 15
Using Surfaces and Point Clouds to Create 3D Design ................................................................... 15
   Inserting features in AutoCAD Utility Design Relative to a Surface ........................................ 15
   Aligning 3D models to Point Cloud Geometry ............................................................................. 16
Summary .............................................................................................................................................. 16
Introduction

About Anchorage Municipal Light and Power
Anchorage Municipal Light & Power (AMLP) provides safe, reliable and affordable electric utility service to over 30,000 residential and commercial customers in its roughly 20-square-mile service territory. AMLP serves commercial, university and medical customers in the Downtown and Midtown business districts, as well as industrial loads in the Ship Creek and Anchorage Port areas and residents in some of Anchorage's oldest neighborhoods. In addition, AMLP provides bulk power to Joint Base Elmendorf-Richardson and sells electricity to other Alaska Railbelt utilities. AMLP is owned by the Municipality of Anchorage, which purchased the distribution system from the privately owned Anchorage Power & Light Co. in 1932. AMLP is subject to the Regulatory Commission of Alaska.

Since 1932, AMLP has grown to include generation and transmission, as well as upgraded and expanded distribution. The utility has a one-third working interest in the Beluga River gas field, making it one of the only vertically integrated natural-gas-fired utilities on the West Coast. The gas field will provide AMLP with a secure and reliable source of fuel for most of its needs through 2018. About 15 percent of AMLP's generation is from renewable hydroelectric resources and the utility has been investing millions in upgrading its aging facility to include clean and efficient natural-gas-fired generation. AMLP is building a 120-megawatt thermal generation plant in east Anchorage which will be one of the most energy efficient thermal-generation plants in the world upon commissioning the end 2016.

How we Got Here
During an Autodesk University 2013 presentation for Denver International Airport, the use of 3D modeling to express the assets underground captured our attention. That same year we saw the advances that had been made in reality capture and photogrammetry and were impressed by the results. Based on these early experiments we identified underground vaults as the best starting point to capitalize on these new processes.

In 2014, we were awarded the Infrastructure in Excellence Award (Small Projects Division) for our work using reality capture to model underground vaults. From that as our starting point, we expanded our use of photogrammetry to include exterior, topographic, and trench models. Additionally we now use handheld 3D scanners inside our vaults, terrestrial laser scanners in our substations, and have incorporated our survey and underground utility locates into 3D design.

In 2015 we focused on increasing our capture quality and scope. We moved from low quality photogrammetry to higher quality photos and terrestrial laser scans. We combined underground data from electromagnetic locating and ground penetrating radar. We worked hard to incorporate this new data into new, 3D design software. Providing 3D utility designs using AutoCAD Utility Design and Infraworks.

It is an exciting time for 3D reality capture. Industries are being shaped by the power of this new technology. At the utility level, there is a shift in how information is captured, communicated, and applied in the field and office. Traditional approaches to data gathering are limited, inconsistent, difficult to efficiently incorporate into design, and are prone to errors and ambiguity. Improved methods allow faster comprehension of higher quality data.

We will be focusing on utility engineering design and the as-built process. While there may be some similarities to structural, architectural, mechanical, or artistic methods, these will not be our primary focus. We will cover the use of survey, LIDAR, photogrammetry, ground penetrating radar and electromagnetic locating from a 3D perspective.
Reality Capture Methods
For additional information and detail on the different reality capture methods refer to the AU 2016 class by Forrest Roy, UT20960 “Capturing Reality, Incorporating Reality Capture into Utility Design and Use in SUE”, a brief summary is covered below for the purposes of this handout

Survey Data
Traditional survey data is gathered in the field using total stations, robotic total stations, or survey grade GPS gear. Once collected it is imported from data collectors and converted into AutoCAD drawings by our survey crew. There are several methods and software packages available to do this, mostly dependent on what brand of survey hardware you are using in the field. All major brands offer methods to add survey data into AutoCAD drawings. We currently have Topcon’s Magnet software which can import survey data directly into AutoCAD drawings though a plugin for AutoCAD or you can export any traditional point file format (.csv, .txt, etc.) to import points into AutoCAD software. We use Magnet software because of the AutoCAD integration and the cloud service which allows us to import/export survey data in real time with our survey crew in the field.

Photogrammetry
Photogrammetry is used to convert photos into point clouds and mesh models, this includes photos taken traditionally and from UAV’s. We upload photos into Recap 360 or ReMake to be processed in the cloud generating, photogrammetric meshes and point clouds models. Once these models have been created they are exported into a RCM format (mesh) or into an RCP file (Reality Capture Project file). For the files to be referenced into real world coordinates, the model must be assigned those coordinates at the creation stage. Getting accurate models from photogrammetry can be very technical and requires a significant level of expertise to get results that are comparable to the other reality capture methods. These processes are very involved and for the purposes of this handout I will not cover any of these methods in depth.

Terrestrial Laser Scans
We use two different types of terrestrial scanners for reality capture, handheld laser scans and tripod mounted scanners.

Handheld laser scanners like the DotProduct are versatile and good for smaller spaces. Because they are mobile you can scan around objects to get angles that would be missed by tripod mounted scanners which capture within line of sight. The DotProduct is limited by not being able to scan in direct sunlight so we have used it primarily for indoor applications or underground infrastructure.

Tripod mounted scanners can gather much larger areas than handheld scanners. They require more planning to identify locations to setup your scanner to capture all relevant data. ReCap allows more flexibility with these types of scans by allowing modification of the survey control after it is registered.

Aerial LiDAR
Aircraft mounted LiDAR, for a long time, was the most effective way to gather larger areas of high quality point clouds that were accurate enough to replace traditional survey. Today they still provide an incredible value even though methods such as tripod mounted laser scanners and UAV photogrammetry have been used for projects where aerial LiDAR used to be the only viable method.
Ground Penetrating Radar
Ground Penetrating Radar is a non-destructive method that uses radar pulses to image the subsurface and is often used for applications such as archeology or utility locating. This method is frequently used in tandem with electromagnetic locating and both have similar interpretation methodologies. Though we have not typically seen GPR used to create point clouds it can be imported into ReCap if exported into the correct format and provides all the functionality of other point clouds for use in design.

3D Underground Locates
There are two standard methods of utility locating; passive and active. In the traditional method, a transmitter is connected to the desired conductor (or inducted indirectly as is the case with electrical cables) and the readings are then read by a receiver. These readings include a variety of information including depth. Locators paint marks on the ground according to a national standard. Some brands of locating equipment have cell grade GPS and perform 3D location logging. We currently use Radio Detection equipment that performs this process. There is also the ability to connect locate equipment to survey grade GPS by Bluetooth. This enables far more accurate location information. This data can be exported as a .csv file and imported into AutoCAD. We also use the depths values to adjust 3D utility paths to accurately represent the depth below grade.

Creating Surfaces from Point Clouds

Creating Point Clouds in ReCap
To create ReCap files there are two methods, registering scan files and generating photogrammetric models. When registering scan data there are limitations based of the type of data you use. Unstructured data (the type of data created from DotProduct handheld scanners) cannot be assigned survey control in ReCap, this means that you should use whatever methods are available in the scanners native software to assign control and combine scans. Aerial LiDAR files and some other .las files cannot be assigned survey control after being imported into ReCap so the coordinate systems should be assigned when the data is created and the original .las files are generated. Terrestrial scan files like those used from Faro tripod mounted scanners are more flexible and survey control can be assigned after they are registered in ReCap.

To create a point cloud file in ReCap using scan data:

- Create a ReCap Scan Project (Figure 1)
- Name your project file and select a folder location (Error! Reference source not found.)
- Add your scan files. Do this by either drag and drop or clicking the “+” sign and browsing to your file locations.
- Select the Advanced icon in the top left of the scan import window (Figure 3 Error! Reference source not found.)
- Adjust the decimation level
- Assign the coordinate system to your scans (current and target systems must both be set to accept the coordinate system)
- Select Import Files (button on lower left of the scan settings window)

You can now select auto-registration or manually register the scans by hovering over the button in the lower right of Import Files window (Figure 4). When manually registering scans you will begin with a base file and begin registering the other files to that scan. During this process ReCap will attempt to match points between the scans to register the files, you can manually augment this process by assigning common points, recognizing targets, and adding survey control. This same process can also be done after you have completed your initial scan project.

To manually register your scans:
- Click on one of the scan files on the left of the window. This will bring up two scans side by side where you can begin to select common targets and points to register the scans (Figure 5)
- Add control points by selecting the icon on the bottom left of the window with three circles
- Add a point by clicking in the body of the scan where you would like to add a reference point (Figure 6)
- Convert point to survey points by clicking the small gray icon below the point location and selecting “make Survey point” (Figure 7)
To select checkerboard targets or spheres that can be recognized by the software select the target button on the bottom of the screen and select the type of target you want the software to identify (Figure 8)

Assign a point number by typing in a number or selecting from the drop-down menu (Figure 9)

To import a Survey Control file use the same drop-down menu but select the option to upload survey points. It is important the format is tab delimited with only four values per row: point number, northing (or X), easting (or Y), and elevation (or Z) with NO description. If you try to import point files that are not in this format your data will not come in correctly and you will not be able to assign the correct survey control to your points. Also the units have to be in meters, ReCap maintains meters as the base unit of measure, if you attempt to assign a coordinate value to your control that is in feet it will treat the units as meters and you will end up with invalid coordinates.

After assigning all points verify the quality of the registration by viewing the quality report and accepting or rejecting the registration (Figure 10)
Generate Terrain Models from Point Clouds in Civil 3D
Any point clouds that are going to be used to generate a surface in Civil 3D need to be cleaned up in ReCap first to remove and points for physical features that you do not want to be part of the terrain. These processes will not be covered in this presentation.

To create a 3D surface from point clouds in Civil 3D:

- Select the "Insert" tab on the ribbon panel (Figure 11)
- Pick "Attach" from the Point Cloud sub-panel
- Go to the “Home” tab (Figure 12)
- Select “Create Ground Data” sub-panel
- Choose “Surfaces” drop down
- Select “Create surface from point cloud”

Depending on what type of point cloud you are importing from ReCap you will probably need to reduce the point density when creating a surface (Figure 13). Typical point densities range from just a few mm for terrestrial scans to a few points per meter for some Aerial LiDAR. Depending on the size of the area the surfaces created from points at that density can burden your system resources to the point of being unusable.

There are several edit options that are available through the Prospector to modify a surface after it is created. If you navigate to the surface you have created, expand the submenus and right-click the edits option, it will give you several different options to modify an existing surface. There are plenty of online tutorials for work in Civil 3D that can teach you the options for modifying your surface.

Generate Terrain Models from Point Clouds in Infraworks
There are pros and cons to generating terrain from point clouds in Infraworks. The terrain generation will automate filtering out points that represent entities other
than the terrain such as buildings, vegetation, vehicles, etc. Alternately, depending on the quality of your point cloud it may generate terrain from points that you do not want to include. Different reality capture methods tend to produce slightly different results. Point clouds from photogrammetry can have a harder time eliminating points that represent objects that you do not want in your terrain because the point patterns are not as consistent as laser scanning methods. It is easiest to work with point clouds in Infraworks if they are correctly geo-referenced.

To import the point cloud into Infraworks:

- Select the “Create and manage your model” menu (Figure 15)
- Pick the “Data sources” button (Figure 16)
- Add a point cloud (Figure 17)
- Right click the point cloud entry in the data sources and select configure
- Choose the coordinate system or manually modify the insertion information (Figure 18), your point cloud should become visible and you can verify it’s insertion and location

- Select the “Analyze Model” button from the Infraworks menu (Figure 19)
- Go to the Point Cloud Terrain button (Figure 20)
- Select the correct point cloud and terrain settings (Figure 21)

It may take some time to generate the terrain depending on the settings, complexity, and size of the point cloud. Once the terrain is generated you
are ready to export the terrain model. You may need to try several different combinations of terrain generation settings to get the desired results.

Export Terrain Model from Infraworks
It is important to note that you should limit the scope of the terrain you export, large terrain models can become difficult to process and render in Civil 3D.

- Select the “Settings and Utilities” menu (Figure 22)
- Chose the “Export to IMX format” icon (Figure 23)
- Define the area of the model you would like to export (Figure 24)
- Select the target coordinate system, location, and file name
- Export your model

When you export an IMX it contains all of the Infraworks entities and can be brought in as a complete model into Civil 3D.
To export a 3D model in one of the following formats .fbx, .dae, and .obj:

- Select the “Settings and Utilities Menu” (Figure 23)
- Click the “Export 3D model format” button (Figure 25)
- Select the area you would like, the file format and any other relevant settings

Figure 25: Export 3D Model

Figure 26: Export to 3D model Dialog
Import Infraworks Terrain into Civil 3D
To convert an .imx file into a surface that can be imported into AutoCAD Utility Design or Map 3D it first needs to be imported into Civil 3D to perform the conversion. Civil 3D will automatically import .imx files:

- Select the Insert tab (Figure 27)
- Choose the Infraworks 360 import button (Figure 29)

This brings in all the model objects in the .imx file including the surface. Now you can export the surface in a format that can be used in other software.

Export Terrain Model from Civil 3D
To convert a surface into a format that is compatible to import into AutoCAD Utility Design and Map 3D you first need to export the surface from Civil 3D:

- Use the Prospector to select a surface
- Right-click the surface and select export DEM

Figure 27: Select Insert Tab in Civil 3D
Figure 29: Import IMX file into Civil 3D
Figure 28: Export Civil 3D surface as DEM
Importing Surfaces and Point Clouds into Design

Import Terrain Models into Map3D
To use a surface Map3D you can to reference the surface as a data layer:

- Open the Map Explorer Task Pane (Figure 30)
- Select the Data Connect button
- Add Raster Image or Surface Connection (Figure 31)
- Select your surface file and click connect
- Add to Map and the surface is ready to be stylized as a data layer

Create Surface from Civil 3D Export in AutoCAD Utility Design
To insert a surface that will you allow you to automate 3D geometry in AutoCAD Utility Design (AUD) is a slightly more complicated process. The default AUD templates will not correctly import the DEM as a data layer and at the time if this presentation I have not identified the method to resolve this issue. There are two alternatives; first you can simply copy the Civil 3D terrain model into AUD (some of the 3D views seemed to have trouble with this method but the geometry worked), second you can recreate the Civil 3D surface in AUD (this process is far more involved but seemed to achieve the best results. To create a surface in AUD you need to load a Civil 3D template file, and convert your surface to either basic lines or points. Because the AUDSURFACE command will not allow you to select a point cloud for surface creation we had to convert a Civil 3D surface created from point clouds into a format that could be used in AUD.
To copy a surface from Civil 3D:

- To recognize the surface you have to import a Civil 3D template into AUD, you do this typing “insert” in the command line (or any other method for inserting a block reference) (Figure 32)
- Select a Civil 3D drawing file with your surface configuration (I saved a blank .dwg from Civil 3D for this)
- Open you’re the Civil 3D file where you created the surface
- Graphically select the surface you would like to import and press Ctrl+C (Figure 33)
- Open the AUD drawing you would like to copy the surface to and press Ctrl+V (you can paste to original coordinates for the best results)

To recreate a surface in AUD:

- Import a Civil 3D template (Figure 32)
- Export your Civil 3D drawing as an AutoCAD file (when you do this it converts your surface mesh to 3D face objects) (Figure 34)
- In the AutoCAD .dwg convert the 3D faces to regions by entering “_region” at the command line
- Select all of the 3D face objects that are part of your surface
- Explode all the newly created regions by typing “explode” in the command line and selecting all relevant regions
- Copy the newly created lines from the AutoCAD .dwg into your AUD drawing (any commonly used method will work, I have used Ctrl+C and Ctrl+v or inserted it as a block and exploded it)
- Create the surface by typing “AUDSURFACE” in the command line (Figure 35)

If you have points you can more easily create a surface in AUD but there is no way to include Point Clouds in the AUD surface creation. That’s why it is necessary to create a surface in Civil 3D first.
Import Point Clouds into AutoCAD

Point clouds in an RCP file format allow for automated import into Autodesk 2017 software. This includes the ability to generate surfaces in Civil 3D directly from the ReCap point clouds or to reference the point cloud into the AutoCAD drawing as an external file that allows 3D snapping functionality.

To import point clouds into AutoCAD:

- Go to the XREF dialog
- Pick the Insert drop-down menu
- Attach Point Cloud

If the point cloud is not on the correct coordinate system or survey control you will need to align the point cloud to your survey data. This can be done using the “Align” command and two common, easily identifiable points that are common to both the point cloud and the survey file. To snap to the points referenced in the point cloud 3D Object Snaps must be enabled (Figure 37).

Using Surfaces and Point Clouds to Create 3D Design

Inserting features in AutoCAD Utility Design Relative to a Surface

Once the surface is inserted in to AutoCAD Utility Design your 3D geometry that is generated when you insert features will be automatically referenced to the assigned surface (Figure 38).

During design you will need to be aware of the edges of your surface because any automatically generated design elements (anchors, guys, guy poles) that fall outside the boundary of your surface will set the elevations to 0 which can cause some significant errors.
Aligning 3D models to Point Cloud Geometry
Using 3D object snaps you can align 3D elements to point clouds, for example aligning a duct run to the duct locations in a vault model or aligning underground infrastructure to GPR point clouds. Depending on the type of feature you are modifying there are a variety of methods to match the 3D feature geometry to the point clouds.

Generating 3D Features from Point Cloud Geometry
For most surface elements you can use the point cloud geometry to generate terrain linework. Features like sidewalk, curb and gutter, landscape features, retaining walls, manhole lids, and other surface type features you can replace traditional topographic survey by using the point clouds in the office. Using 3D object snaps and creating 3D polylines you can trace point cloud elements to recreate curb and gutter, sidewalk, building outlines, foundation outlines etc. Outside of the traditional AutoCAD commands there are some point cloud specific commands that can simplify parts of this process.

Figure 39: 3D View of Point Clouds and 3D Design in AutoCAD Utility Design

Summary
Three dimensional design has been a growing platform decades. The unique design challenges associated with civil and utility construction have made it difficult to fully embrace a 3D design methodology. Traditionally designs were created based on the best available information but inherently had a margin of error that was resolved during construction. Field crews were required to slow down or stop while unknown conditions necessitated design changes. As-builts were marked up by hand and did not always capture the full scope of what was actually installed.

Reality capture fills an important role in being able to visualize existing conditions and create 3D designs that are grounded in the real world. Incorporating the ability to visualize and design based on information that was previously unknown allows for more efficient and higher quality engineering designs. This in turn results in more accurate engineering analysis, lower construction and design costs, better as-builts, and improved safety by reducing the need to physically visit assets. Bringing the outside world into the office using reality capture to design, visualize, collaborate, and analyze is the future of making things.